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ControlCenter 3

1 ControlCenter

USB Control Center is used to communicate with USB devices that are served by CyUSB.
sys device driver, Microsoft’s usbstor.sys and Microsoft’s hidusb.sys. We can also select any of the
above drivers and view only the devices served by those drivers using check boxes in Device class
selection Tab page.

bgs LISB Control Center,

; hienn
File  ProgramFxZ  Help Ear
- =~ O [ﬁ [#] select Monitor  Load Maonitar URE Skat  Abort Pipe Reset Pipe & % (E g— Tanol
- : T " B
(= CvStieam Deviee [3.4.0.90] Deseriptor Infa | Data Transfers | Device Class 5 election 2
& Configuration ; skisai i e B0 Bt st s st B —
Control endpaint [0:00) aisine o]
| P Friendlyt ame="CStream Device [3.4.0.90]" E
= Interface 0 b anufacturer="Cypress"
=) Alternate Setting 0 F'rogjuct="E'T'-Stream"
Bulk in endpoint [0x32) ge”?lNu”:bEF“:_l -
& . onfigurations=
= Alkernate Setting 1 _ W anP ack stSize="F4"
Bulk. out endpaoint [0x02] YendarlD="04 B4"
= Alternate Setting 2 ProductiD="10 03"
Bulk in endpoint [0x82] E|aSS="DD|'I1I" .
Bulk aut endpoint [0+08) Subllass="00h
1 : Pratocol="00k
= Alternate Setting 3 BedDevice="00 00"
lzoc in endpoint [0=82) BedUSE="02 00"
= Alkernate Setting 4 <CONFIGURATION:
Izoc out endpaint ((x02] Configuration="0"
G- Altarmate S atting 5 Eorjhgurahon\-"alue: 1
: g : Altributes="A0K"
lgac in endpoint [0=82) |nterfaces="1"
= Alternate Setting & De&criptan_l,Jpe="2"
|z0c in endpaint [0:52) ?E?'Dlﬂptﬂft;r?%tgg::gn
: otalLength=
lgoc out endpaint [0=0E] b aPoviar="50"
<INTERFALCE >
Interface="0"
Imterfacet umber="0"
AltSetting="0"
Class="FFh"
Subclazz="00R"
Protocol="0"
Endpoints="17"
DezcriptarType="4"
DezcriptarLength=""3"
<EMDPOIMT » |
Status
— Bar
Dievrice Tree | | Tab Pages
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s LISB Control Center

File  Program F&z  Help

Pem @ 0 % @8 [ select Monitor  Load Monitor URB Stat Abort Pipe ResetPipe X & 0 £
= CrStream Device [3.4.0.90) | Descriptar Infnj Data Transfers | Device Clazs Selection |
= Configuration — |[
Control endpaint [Qx00) Text to zend [ata to zend [Hex)
= Interface 0 | | [_ |

[=- Alternate Setting 0
' Bytes to Transt
Bulk in endpaint (0x82) T

—|- Alternate Setting 1 2] [] PkiMode

=

Bulk out e.ndpu:unt (0:02) [ Tranzfer Data J [ Tranzter File ]
| .&.Iternate Setting 2

Bulk in endpaint [0=82]
Bull. out endpoint [0=0E)
[=- Alternate Setting 3
lsacin endpoint [0x82]
[=- &lternate Setting 4
" leoc out endpoint [0x02)
[=- &lternate Setting 5
oz in endpaint [0x82]
= Alternate Setting &
o lzocin endpoint [0x82]
|z0c aut endpaint (0=06)

1]

1}
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ig# LISB Control Center

File  Program FXz  Help

PEE [ o & d8) ] Select Monibor  Load Monikar URE Stat Abort Ppe ResstPipe ¥ &b B £
= Cy'Stream Device [3.4.0.90] | Degcriptmmf.;'.; Data Transfers | Device Class Selsction |

(=) Configuration 1
Contral endpoint [0=00)
Interface 0
(=) Alternate Setting 0 Devices served by the CylUSB. sps driver [or a derivative)
Bulk in en.dpcunt (0x82) Mazz Storage Claze Devices
= Aalbernate Setting 1
Bulk out endpaint [0:02] Human Interface Devices [HID]
= Alternate Setting 2
Bulk. in endpoint [0=82]
Bulk. aut endpaint (0=06)
=) Albernate Setting 3
|20z in endpaint [0=82)
- Alternate Setting 4
lzoc out endpoint [0=02]
-] Akernate Setting 5
|20 in endpoint [0=82)
- Alternate Setting &
|z0c in endpoint [0=82)
lzoc out endpoint [Ox0E]

Select the USB devices of interest.

i

o

)

i

i

|

11 Menu Bar

File  Program F¥2  Help

1. File
2. Program FX2
3. Help

111  File

File | ProgramFXz  Help
H ] et

File -> Exit — used to exit the control center application.
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11.2 Program FX2

File | Program Fx2 | Help
R.AM
Smiall EERRCM
B£4kKE EEPRCM
Halt
Run

Program FX2 -> RAM — used to load the selected FX2’s RAM with firmware (.hex).

Program FX2 -> Small EEPROM — used to program 256-byte EEPROMSs. When this is selected,
the user is prompted to select a (.iic) file to load into the EEPROM.

Program FX2 -> 64KB EEPROM — used to program 64-Kbyte EEPROMSs. When this is selected,
the user is prompted to select a (.iic) file to load into the EEPROM.

Program FX2 -> Halt — performs a CPU Reset of the selected FX2.

Program FX2 -> Run — releases the CPU Reset of the selected FX2.

113 Help
File  Program FxZ | Help
Help Topics
Ahaouk

Help -> Help Topics - Opens the ControlCenter User guide.

Help -> About — displays the Assembly version and ControlCenter version.
1.2 Tool Bar

Pew (@ % @8 [ select Monitor  Load Monitar URBStat Abort Pipe ResetPipe X & (B #7

Ebhort Endpoint

Flay script Resat Enﬂpoint.
Load sScript Reconnect Device
Script Parameters
Create Script
Insert 1l00ms wait
Stop Recording
Start Recording

Reset Davice

1. Scripts.
2. Monitor.
3. URB Stat.
4. Pipe.
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5. Endpomt.
6. Device.
1.21 Scripts

Control Center provides a mechanism for creating and re-playing a sequence of data transactions.
The Scripts can be loaded into a particular device while installation by specifying it in the .inf.

P|k ([ @ % @B [ select Monitor  Load Moritar IURE Stat  Abort Pipe  Reset Pipe & % 0 =

Play sBcript
Load Script
Script Parameters
Create Script
Insert 10oms wait
Stop Recording
Start Recording

Start Recording - Used to begin the script recording. Records the transactions done using Transfer
Data button
and Transfer File button. This won't record the transactions done using RAM download.

Stop Recording - Used to stop the recording initiated by Start Recording button. Asks to save the
script file.

NOTE : Start/Stop Recording does not record firmware download operation.
Insert 100ms wait - Writes a 100ms delay in the script.

Create Script — Used to create a script from a .hex file only. Parses the hex file and generates script
file.

Steps,
1. Select a hex file.
2. Save the script file as.

Result is displayed in Status bar.

© 2011 Cypress Semiconductor
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1.2.2

123

Script Created: Du\bulkloop,spk

Script Parameters — Used to change the Location of CPUCS register and Maximum mnternal
Address before creating script.

Load Script — Used to get the name and location of the script file to be played.
Play Script — Plays the loaded script using vendor commands onto the selected FX2 device.

Monitor

i@k = @ % @ [ Select Monitor  Load Monitor IURE Stat  Abort Pipe Reset Pipe & % (L

Load Monitor
Select Monitor

Select Monitor — used to get the name and location of the monitor file to be loaded.

Load Monitor — used to load the selected monitor to the selected FX2’s RAM.

URB Stat
Displays the state and status of last URB(USB Request block) to the client driver in the Status bar.

© 2011 Cypress Semiconductor
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s LISB Control Center

File  Program FXZ  Help
faEw &

B [:_@ [*] select Monitor  Load Monikor

= Cyprezs EZ-1SE Example Device [3.4.0.90)
= Configuration 1
- Contral endpoint [0x00)
= Interface 0
= Altermate Setting 0
Bulk. aut endpaint [0=02)
Bulk out endpaint [0=04)

Bulk in endpoint [[x86]
Bulk in endpoint [0x88]

Test to zend D ata to zend [Hex)

|E3 7AT072BR 7373

i CYpress

Bytez to Transfer
| 512| [ Pkitade

Tranzfer Data{M Tranzfer File-IM

Last URE Error = 0x0 [state=SUCCESS status=USBD_STATUS_SUCCESS]

1.24 Pipe

Abort Pipe — used to clear pending data transfers on the endpoint.

Reset Pipe — used to reset the selected endpoint.

Result displayed in Status bar.
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s LISB Control Center

File  Program FXZ  Help

@R @ % @8 [ selectMonitor  Load Mornitar IURE Stak  Abort Pipe  Reset Pipe K % M =
= CvStream Device [3.4.0.90) E-Descripturlnfu-i Data Transfers |Device Clazs Selection |
= Configuratonl [T -
- Contral endpoint [0x00) Test to zend D ata to zend [Hex)

= Interface 0 | | | |
= Alternate Setting 0

Bytez to Transfer

Bulk in endpaint [0x82] |
= Alternate Setting 1 | 512] [ Phitade

Bulk. out e.nclpolnt [0=02] Transfer DatadN S
= Altemnate Setting 2

Bulk in endpoint [0x82]
Bulk. out endpoint [0=06)
[=) Alternate Setting 3
: |zoc in endpoint [0482]
= Alternate Setting 4
' |z0c aut endpaint [0=02)
[=- &lternate Setting 5
: |20z in endpoint [0x82]
(=) Altermate Setting B
lzoc if endpoint [0x82]
lgoc out endpoint [0=06]

Abart Pipe Successful

© 2011 Cypress Semiconductor
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125

1.2.6

s LISB Control Center

File  Program F&z  Help

(=] Cyprezs EZ-USE Example Device [3.4.0.90)

(=) Configuration 1
Control endpaint [Qx00)

= Interface 0
[=)- Alternate Setting 0
- Bulk out endpaint [0x0Z2]
Bulk. out endpoint [0=04)
Bulk in endpoint [086]
Bulk in endpaint [0=83)

= E @ o R E@ [] select Monitor  Load Monitor URE Stat  Abort Pipe Reset Pipe A& % (B g
j_l_:_)__e_SE[iE_t_u:ur_l_rlf?_j Drata Transfers | Device Class Selection |
Text to zend Data to send [Hex]
| cypress | [s37a7072857373 |

Bytes to Transfer

512 (] PkiMode
[ Tranzter Data-M J [ Tranzfer File-IM ]

Reset Pipe Successfull

Endpoint

Abort Endpoint — used to clear pending data transfers on the endpoint. Same as Abort pipe.

Reset Endpoint — used to reset the selected endpoint. Same as Reset pipe.

Result displayed in Status bar.

Device

Reconmnect Device — used to reconnect the selected FX2 device.

Reset Device — used to reset the selected FX2 device.

© 2011 Cypress Semiconductor
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¢ LISB Control Center.

File  Program Fx2  Help

(=5 El @ = ?‘k [ﬁ El Select Monitor  Load Monikar

URE Stat AbortPipe ResetPipe X & (B #F
# Cyprezz EZ-115B Example Device [3.4.0.90)

E-Descriptu:ur Info | Data Transfers ] Device Class Selection |

Test to zend [1ata to zend [Hex)

| cyppress | |63737072657373 |
Bytez to Transfer
[ 512 | [] PhiMoade

Device Reconnected

© 2011 Cypress Semiconductor
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bg# LISB Control Center

File  Program F¥z  Help
== E B [@ [¥] select Manitor  Load Maritor LIRE Skat  Abort Pipe  Reset Pipe % G} g

Cypresz E£-USE Example Device [3.4.0.90)

[rata to zend [Hex)

Text to zend
|6379 7072657373 |

|cy|:uress |
Bytez to Transfer

512j ] Pkitods

Device Reset Successhull
1.3 Device Tree View
Displays all the USB devices connected and served by the device drivers which are enabled using

Device Class Selection.

© 2011 Cypress Semiconductor
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=l C1'Stream Device [3.4.0.90)
[=I- Configuration 1
Control endpaint [Dx00]
= Interface 0
= Alternate Setting 0
Bulk in endpoint [0x82]
|- Alternate Setting 1
Bulk. aut endpaint [0=02]
|- &lkernate Setting 2
Bulk. in endpoint [0x82]
Bulk. out endpaoint [0=06]
|- &lkernate Setting 3
|zoc in endpoint [0=82]
|- &lkernate Setting 4
|zoc out endpoint [0=02]
|- Alternate Setting B
|zoc in endpoint [0=32]
|- Alerhate Setting B
|zoc in endpoint [0=32]
|zoc out endpaint [Ox06]

Hot-plugging of USB devices is supported in Control Center. When a device that matches to the
specified driver is plugged-in to the PC it will automatically appear in the Device tree view. Similarly
unplugging a device will also be updated in the device tree.

User can expand the devices in the device tree by clicking on the + sign to the left end of the device
and can select appropriately.

Ifthe selected device is a FX2 device, user can view the configurations which on expanding shows
the control endpoint and interfaces. Each interface on expanding shows the Alternate Settings which
in turn contains endpoints. While selecting Alternate Setting in device tree, a set Interface request will
be sent to the device. Similarly selecting an endpoint in any other Alternate Setting also sends a set
Interface request to the device.

Ifthe selected device is a HID device, user can view features or inputs or outputs of the device
which in turn will contain buttons or values on expanding.

© 2011 Cypress Semiconductor
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14 Tab Pages

1. Descriptor Info
2. Data Transfers

3. Device Class Selection

141 Descriptor Info

Displays the descriptor information of the device selected in the device tree.

Descriptar Info | Data Transfers | Device Class Selection

<DEVICE> A,
FriendluM ame="Cyprezz EZ-LISE Example Device [3.4.0.55]"
b anufacturer=""Cypress"’
Product="EZ-LU5E"

Senaltumber=""
Configurationsz=""1"
MaxPacketSize="64"
WendarlD=""04 B4"
ProductiD="10 04"
Clagz="00k"
SubClazz="00k"
Frotocol="00k"
BodDewice="00 00"
BcdUSE="02 00"
<CONFIGURATION:
Configuration=""0"
Configurationtalue=""1"
Aftributes="80K"
Interfaces="1"
DeszcrptorType=""2"
DezcriptorLength=""3"
T otalLength="4£""
b axPower="00"
<INTERFALCE >
Interface="0"
InterfaceMumber=""0"
AltS etting="0"
Clazz="FFh"
Subclasz="00K"
Pratacal="0"
Endpoirts=""4"
DezcrptorType="4"
Dezcriptorlength=""3"
<EMDPOIMT > w

14.2 Data Transfers

1. Transfer Data
2. PktMode

3. Transfer File
4. Clear Box

15
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Descriptor Info | Data Transfers | Device Class Selection

Text to zend Drata to send [Hex)

Bytes to Transfer

512/ [] Fkitode

Tranzfer File Clear Box

When the device selected has multiple configurations this Page will be disabled.
1.4.2.1 Transfer Data

Ifthe device selected using device tree is R/W accessible, this button will be enabled.

Data entered in “Text to send” field will be automatically converted to byte and displayed in “Data to
send” field and vice versa. Value of “Bytes to Transfer” field is also automatically updated.

Incase of HID devices this button will be changed to get/set + mput/output and Get Feature if
Feature is selected.

1.4.2.1.1 Control Transfer

Steps for Control Transfer,
1. Select the control endpoint using the device tree.
Indicate whether the data is to be sent to the device (OUT) or read from the device (IN)
using the Direction Combo box.
3. Indicate the type of request (Standard or Class or Vendor) using the Req Type Combo

© 2011 Cypress Semiconductor
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box.

4. Indicate the target (Device or interface or endpoint or others) of transfer using Target
Combo box.

5. Enter the byte representing the vendor request command code in the Req code field.

6. Enter the two-byte hexadecimal value for the vendor request’s wValue parameter in the
wValue field.

7. Enter the two-byte hexadecimal value for the vendor request’s windex parameter in the
wlndex field.

8. Ifthe direction is OUT, fill the data to be sent in “Text to send” field or if the direction is
IN, fill the “Bytes to Transfer” field with the size of data expected from device and
mitiate the transfer using Transfer Data button.

bgs LISB Control Center

File  Program FxZ  Help

= RO

% @8 ] select Monitor  Load Manitor URE Stat Abort Pipe ResetPipe X & B £

= CvShream Device [3.4.0.50)
[=) Configuration 1

Contral endpaint [Ox00)

| Interface 0

[=- Alternate Setting 0

Bulk in endpoint [0x82)
= Alternate Setting 1

Bulk. aut endpaint [Dx02)
= Altemate Setting 2

Bulk in endpoint [0x82)

Bulk aut endpaint [0x08)
= Alternate Setting 3

lzoc in endpoint [0x82]
[=- Alternate Setting 4

lzoc out endpoint [0«02]
= Altemate Setting 5

lzoc in endpoint [1x82]
(=) Alternate Setting &

lzoc in endpaint [0x82)

lzoc out endpoint [0x06]

|| Desciptor Inf | Data Transfers | Device Class Selection|

Teut to zend Data to zend [Hex)

..& Cz2

Biytes to Tranzfer

' 1 [ Pkttode

Direction f'Dut.v_ Feq Twpe :'\!’endor v Target iDevice -v':
Reg Coderﬂi‘-.D whalue I_UHUUUU ' windex UHUUUU

CONTROL OQUT transfer
aooa cz
CONTROL OUT transfer completed

© 2011 Cypress Semiconductor
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bgs LISB Control Center,

File  Program Fx2  Help

i@k = B % @8 [ select Monitor  Load Monitar URE Stat Abort Pipe ResetPipe M & @ £
= C¥Stieam Device (3.4.0.90) Descriptor Info | Data Transfers | Device Class S election
& Canfiqueation 1 e BRI OLUD; EElbE ey A re OO
Control endpaint [0x00] Test to zend Data to zend [Hex)
o et el b e s

]

- Altemnate Setting 0 = R —
' : Biptes to Transfer
Bulk in endpaint [082) S EE e RS O Fieod
= Altemate Setting 1 1 ode

. Bulk out endpoint [(=02] T i

= Altermate Setting 2

Bulk in endpoint [0x82)

Bulk out endpaint [Ox0E]
= Altemate Setting 3 A SRR SR

ls0c in endpaint [0%82] FeqCode 0«06 | wialue |0x0200 | windes |0:0000 |
=) Alternate Setting 4

|20z out endpaint [0x0E]
=) Alternate Setting 5

le0z in endpoint [0x82]
[=)- Altermate Setting B

|zoc in endpoint [0x32]

|z0c out endpoint [0x08]

|

Direction i.ln \_f Req Type :.Standard-;; Target iDevice W |

CONTROL IN transfer
aooo o3
CONTEOL IN transfer completed

1.4.2.1.2 Non Control Transfer

Steps for Non-Control Transfer,

1. Select the endpoint using the device tree.

2. Since the endpoints are already configured to be IN or OUT clicking the Transfer Data
button will receive specified number of bytes (if IN endpoint) or sends the data filled in
“Text to send” field (if OUT endpoint).

© 2011 Cypress Semiconductor
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Ags# LISB Control Center

File  Program FxZ  Help

= \[x] Co @ [»] select Monitor  Load Monitor

URE Stat  abork Pipe  ResstPipe & % ¥ #

= Cypress EZ-USE Example Device [3.4.0,90)
=] Configuration 1
i+ Control endpoint [0x00]
= Interface 0
=) Alternate Setting 0
Bulk out endpoint [0=02)
Bulk out endpoint [Ox04)
Bulk in endpaint [0x3E]
Bulk in endpoint [0=88)

Text bo send Data to zend [Hex)

| cypress | BATITOF2E573TI |
Bytez to Transfer
[ 7| [ PkiMade

Transfer Data-0UT | Transfer File-OUT
EULE 0UT transfer

oooo &2 7?9 70 TE 65 73 73
BULE 0UT transfer completed

Programming succeeded.

© 2011 Cypress Semiconductor
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Ags LISB Control Center

File  Program F¥2  Help

= [ R 8 @ [#] select Monitor  Load Maonikar

URE Stat abortPipe ResstPipe X & B £

= Cppress EZUSE Exampls Device (3.4.0.90] | Descriptor Info | Data Transfers | Device Class Selection

(=) Configuration 1
Control endpoint [Ox00]
= Interface 0
=) Alemate Setting 0
Bulk aut endpaint [0x02]
Bulk out endpaint [0x04)
Bulk in endpoint [0=86]
Bulk i endpoint [0x38]

Programming succeeded.

1.4.2.2 PktMode

Text to zend Data to gend [Hesx)
|cypress (637970726573 73
Bytes ta Transter

B 512] [ Pkitode

Transfer File-IN

o000 &3 79 7?0 7E 65 73 73
BULKE 0OUT transfer completed

Transfer Data-IM

|BULE 0UT transfer

BULKE IN transfer
oo &3 79 7?0 7 65 73 73
BULKE IN transfer completed

This check box can be used to receive the Partial data during Bulk/Interrupt IN transfer.

1.4.2.3 Transfer File

This button is visible only if the selected node is a device served by “CyUSB.sys” or a “Feature”.

Ifthe selected node is a device served by CyUSB.sys,

Steps,

1. Select an OUT endpoint using the device tree.

Click the "Transfer File-OUT" button. Select the file to send(here it will send the number of

bytes available in the file), contents will be displayed in the output box.

Specify the number of bytes to be written into the file in the "Bytes to Transfer" field .

2.

3. Select the IN endpoint.

4.

5. Click the "Transfer File-IN" button.
6. Save the file.

Ifthe selected node is a Feature of HID device, "Transfer file" button will be changed to "Set

Feature" button.

© 2011 Cypress Semiconductor



ControlCenter 21

i ; USB Control Center

File  ProgramFXZ  Help.

P@e = [® 0 % @8 [ Select Monikor  Load Manitor URB Stat Abort Pipe ResetPipe X S @ 7

= I:__I,Ipfess EZ-USE Example Device [3.4.0.90) Dezcriptor Info [ Data Transfers | Device Class Selectiun|
= Configuration 1

Control endpoint [Ox000)

; Test to zend D ata to zend [Hex)
= Interface 0 cypress | [63797072657373 |
[=- &lternate Setting 0
: Bytes to Transf
Bulk out endpoint [0+02) i

Bulk ot endpait [0404) T L] Phitode

Bulk in endpaint [1«8E]

Bl i endpoint (048] Tranzfer Data-0UT Tranzfer File-QIJT

Select the file to send

Look in: | (=3 Check

V| (¢ [ s ik

\l

by Recent
Documents

by Documents

-

hy Carmputer

File name: ‘ Cypress. bt W | L Open ,]

Files af type: |.~'1'«II filez [

L

W | [ Cancel ]

My Metwork []Open as read-only

© 2011 Cypress Semiconductor
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File Help -

=0 o B 8 ] select Monitor  Load Monikar URE Stat Abort Ppe ResstPipe X & @B £

= Cypresz EZ-USE Example Device (3.4.090] | | Descriptar Infﬂ D ata Transfers | Device Class Selectiu:un|
(=) Configuration 1 -

P Contral endpoint [0=00) Test to zend [rata to zend [Hex)
= Interface 0 cypress | |E3TITOTZESTITI |
[=- &lternate Setting 0
: Bytes ta T fi
... Bulk out endpoint (0x02) s

... Bulk out endpoint (0x04] T [ Phitfode
ga:t :: E:SEE::: Eg:gg} Tranzber Data{M - Transfer File-IM
|BULK 00T transfer

|IZII:IIZIIZI £3 79 70 7E &5 73 73
|BULE. OUT transfer completed

Program Fx2

Save Data to file:

Save in: |E}Eheck v| € ?, e [
L;g [£] Cypress.bxt
My Recent
Diocuments
€
Desktop

by Diocuments

File selected. ... D:hChe

by Cormputer
Q File name: iCypressEupﬂ |_V]| [ Save ]
MyMNetwok  Saveastype: | Allfles (7] v| [ cance |

1.4.2.4 Clear Box
Clear Box clears the Output box and Status bar below.
1.4.3 Device Class Selection

It is used to select the devices of our nterest. Control Center supports USB devices of the following
3 classes.

1. Devices served by CyUSB.sys driver.

2. Mass storage device class.

3. Human interface device class.

© 2011 Cypress Semiconductor
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User can enable or disable a class which will reflect in the device tree.

Descriptor Info || Data Transfers | Device Clazs Selection

Select the USB devices of interest.
Devices zerved by the CylJSEB. zuz driver [or a derivative]
b azz Storage Clazs Devices
Human Interface Devices HID]

23
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